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Application Notes for Configuring Avaya IP Office 10.1 with
Swisscom Smart Business Connect — Issue 1.0

Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) trunking between Swisscom Smart Business Connect and Avaya IP Office.

Swisscom Smart Business Connect provides PSTN access via a SIP Trunk connected to the
Swisscom Voice over Internet Protocol (VolP) network as an alternative to legacy analogue or
digital trunks. Swisscom is a member of the Avaya DevConnect Service Provider program.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) trunking between Swisscom Smart Business Connect and Avaya IP Office. Customers
using this Avaya SIP-enabled enterprise solution with Swisscom’s SIP Trunk are able to place
and receive PSTN calls via a dedicated Internet connection and the SIP protocol. This converged
network solution is an alternative to traditional PSTN trunks. This approach generally results in
lower cost for the enterprise customer.

2. General Test Approach and Test Results

The general test approach was to configure a simulated enterprise site using Avaya IP Office to
connect to the Swisscom Smart Business Connect SIP trunk. This configuration (shown in
Figure 1) was used to exercise the features and functionality listed in Section 2.1.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.

Avaya recommends our customers implement Avaya solutions using appropriate security and
encryption capabilities enabled by our products. The testing referenced in these DevConnect
Application Notes included the enablement of supported encryption capabilities in the Avaya
products. Readers should consult the appropriate Avaya product documentation for further
information regarding security and encryption capabilities supported by those Avaya products.

Support for these security and encryption capabilities in any non-Avaya solution component is
the responsibility of each individual vendor. Readers should consult the appropriate vendor-
supplied product documentation for more information regarding those products.
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2.1. Interoperability Compliance Testing

Avaya IP Office was connected to the Swisscom Smart Business Connect SIP trunk via a VPN
established over the internet.

To verify SIP trunking interoperability the following features and functionality were exercised
during the interoperability compliance test:

Incoming PSTN calls to various phone types including H.323, SIP and analogue
telephones at the enterprise. Calls routed to the enterprise via the SIP trunk from
Swisscom.

Outgoing PSTN calls from various phone types including H.323, SIP and analogue
telephones at the enterprise. Calls routed from the enterprise via the SIP trunk to
Swisscom.

Inbound and outbound PSTN calls to/from an Avaya Communicator for Windows client.
Various call types including: local, international, toll free (outbound) and directory
assistance.

Calls using G.711A, G.711MU and G.729A codec’s.

Caller ID presentation and Caller ID restriction.

DTMF transmission using RFC 2833.

Voicemail navigation for inbound and outbound calls.

User features such as hold and resume, transfer, and conference.

Off-net call forwarding and mobile twinning.

2.2. Test Results

Interoperability testing of the sample configuration was completed with successful results for
Swisscom Smart Business Connect. The following observations were made during the test:

When making an outbound call that was not answered, after ninety seconds the ringback
tone stopped and there was silence. Expected behaviour is a failure tone or an
announcement.

When making an outbound call to an invalid number, the network sent 200 OK (Answer)
before playing an announcement. The behaviour more commonly observed is for a
backwards transmission path established using SIP 183 Session Progress to be used to
play a tone or announcement to the caller. Using 200 OK completes the SIP dialogue and
establishes the call making it indistinguishable from a successful call.

When making some calls with multiple PSTN endpoints, for example conferencing,
audio delays were observed. These were deemed to be a characteristic of the test
environment and not a SIP interoperability issue.
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2.3. Features Not Tested

The following features and functionality were not tested:
e No inbound toll-free access was available for testing
e Emergency Calls were not tested as the IP Office location data was not defined.
e Fax was not tested as this is not offered to Swisscom customers on IP Office.

2.4. Support

For technical support on the Avaya products described in these Application Notes visit
http://support.avaya.com.

For technical support on Swisscom products please contact the Swisscom support team: Email:
cbu.incident-voice@swisscom.com.
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3. Reference Configuration

Figure 1 illustrates the test configuration. The test configuration shows an enterprise site
connected to Swisscom Smart Business Connect. Located at the enterprise site are an Avaya IP
Office Server Edition and an Avaya IP Office 500 v2 as an Expansion. Endpoints include an
Avaya 1600 Series IP Telephone (with H.323 firmware), Avaya 9600 Series IP Telephones (with
H.323 firmware), an Avaya 1140e SIP Telephone and an Avaya Analogue Telephone. The site
also has a Windows 7 PC running Avaya IP Office Manager to configure the Avaya IP Office as
well as Avaya Communicator for Windows for mobility testing. For security purposes, PSTN
routable phone numbers used in the compliance test are not shown in full.
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Figure 1: Swisscom Smart Business Connect to Avaya IP Office Topology
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4. Equipment and Software Validated
The following equipment and software were used for the sample configuration provided:

Equipment/Software | Release/Version
Avaya

Avaya IP Office Server Edition 10.1.0.0.0 build 237
Avaya IP Office 500 V2 Expansion 10.1.0.0.0 build 237
Avaya 1140e IP SIP Telephone 04.04.23.00

Avaya 1608 IP Phone (H.323) 1.350B

Avaya 9611 IP Phone (H.323) 6.6.4.01

Avaya 98390 Analogue Phone N/A

Avaya Communicator for Windows 2.1.4.0

Avaya IP Office Server Edition Manager Version 10.1.0.0.0 build 237
Swisscom Smart Business Connect

Cisco C881-K9 Integrated Services Router | 10S 15.6

Testing was performed with IP Office Server Edition with 500 V2 Expansion R10.1. Compliance
Testing is applicable when the tested solution is deployed with a standalone IP Office 500 V2
and also when deployed with all configurations of IP Office Server Edition. Note that IP Office
Server Edition requires an Expansion IP Office 500 V2 to support analog or digital endpoints or
trunks.
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5. Configure Avaya IP Office

This section describes the Avaya IP Office configuration to support connectivity to Swisscom
Smart Business Connect. Avaya IP Office is configured through the Avaya IP Office Manager
PC application. From a PC running the Avaya IP Office Manager application, select Start >
Programs - IP Office - Manager to launch the application. Navigate to File > Open
Configuration (not shown), select the appropriate Avaya IP Office system from the pop-up
window and log in with the appropriate credentials. A management window will appear similar
to the one in the next section. All the Avaya IP Office configurable components are shown in the
left pane known as the Navigation Pane. The pane on the right is the Details Pane. These panes
will be referenced throughout the Avaya IP Office configuration. All licensing and feature
configuration that is not directly related to the interface with the Service Provider (such as
mobile twinning) is assumed to already be in place.

-
f Select IP Office = B =

MName IP Address  Type Version Edition
Server Edition 10.1
ipol00sery 10104101 IPO-Linux-PC  10.1.0.0.0 build 237  Server (Primary) Select

Canfiguration Service User Login
IP Office: ipol00sery (Primary System - IPO-Linux-PC)
Service User Name Administrator
Service User Password  essssssss
[ oK l ’ Cancel ] [ Help

TCP Discovery Progress

Open with Server

Unit/Broadcast Address Edition Manager
10104101 - oK ] [ Cancel
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5.1. Verify System Capacity

Navigate to License in the Navigation Pane. In the Details Pane verify that the License Status
for SIP Trunk Channels is Valid and that the number of Instances is sufficient to support the

number of channels provisioned for the SIP trunk.

File Edit View Tools Help

13 [@&E 4] v

| Configuration |

=& BOOTP (9)

¢« Operator (3)
E-%57 Solution

@ User(34)

]--ﬁ Group(l)

- @M Short Code(45)
-8 Directory(0)
-£17 Time Profile(0)
-l Account Code(0)
H-fig User Rights(d)
-8 Location(0)

=427 ipol00sery
(%57 Systemn (1)
B4 Line (3)
-2 Control Unit (11)
(-4 Extension (4)
@-§  User (5)
@ Group (0)
-8 Short Code (53]
- Service [0)
#-§P Incoming Call Route (4)
a4 Directory (0)
| {71 Time Prafile (1)
Ell IP Route (2)
8 Account Code (0)

- Licence (23)
a 3 User Rights (9)

&

e

Licence | Remote Server

PPN -

Feature Instances Status Expiry Date Source

Receptionist 10 Valid 14/03/2018 PLDS Modal
Additional Voicemail Pro Ports 252 Valid 14/03/2018 PLDS Medal
VMPro Recordings Administrators 1 Valid 14/03/2018 PLDS Modal
Office Worker 1000 Valid 14/03/2018 PLDS Medal
VMPro TTS Professional 40 Valid 14/03/2015 PLDS Modal
IPSec Tunnelling 1 Obsolete 14/03/2018 PLDS Medal
Power User 1000 Valid 14/03/2018 PLDS Medal
Avaya IP endpoints 1000 Valid 14/03/2018 PLDS Medal
SIP Trunk Channels 256 Valid 14/03/2018 PLDS Modal
IP500 Universal PRI (Additional cha... 100 Obsolete 14/03/2018 PLDS MNodal
CTILink Pro 1 Valid 14/03/2018 PLDS Modal
Wave User 16 Obsolete 14/03/2018 PLDS Modal
3rd Party IP Endpoints 1000 Walid 14/03/2018 PLDS Medal
Server Edition R10 150 Valid 14/03/2018 PLDS Modal
UMS Web Services 1000 Valid 14/03/2018 PLDS Medal
Avaya Mac Softphone 1000 Valid 14/03/2018 PLDS Modal
Avaya Softphone Licence 1000 Valid 14/03/2018 PLDS Medal
SM Trunk Channels 128 Valid 14/03/2018 PLDS Medal

m

Add...

Remove

m

5.2. LAN2

In the sample configuration, the LAN2 port was used to connect the Avaya IP Office to
Swisscom Smart Business Connect. To access the LAN2 settings, first navigate to System =
<IP Office Name> in the Navigation Pane where <IP Office Name> is the name of the IP
Office. This is ipo100serv for the Server Edition in the GSSCP test environment. Navigate to the
LAN2 - LAN Settings tab in the Details Pane. The IP Address and IP Mask fields are the
external interface of the IP Office. All other parameters should be set according to customer
requirements. On completion, click the OK button (not shown).

Configuration

ipo100serv

- & BOOTP (9)

H-¢w Operator (3)

-5 Solution

E-f User(34)

-4 Group(l)

-8 Short Code(45)
----- @ Directory(0)

----- £ Time Profile(0)
----- Bl Account Codel(D)
G-fig User Rights(9)
[ Location(1)
=457 ipol00sery
System (1)

2 ipol00sery
-9 Line (2)

| System | LANL | LANZ | DNS | Voicemail | Telephony | Directory Services | System Eventsl SMTP |

LAM Settings |‘u’oIP | NetworkTopoIogyl

IP Address

IP Mask

DHCP Mode

) Server

192

255

Nurnber Of DHCP IP Addresses 80

) Client @ Disabled

168 20

255 . 255

4

20

0
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On the VVolIP tab in the Details Pane, check the SIP Trunks Enable box to enable the

configuration of SIP trunks. Scroll down for further configuration. Define Keepalives as
required, during testing RTP-RTCP was used with a Periodic Timeout of 5. The RTP Port
Number Range can be customized to a specific range of receive ports for the RTP media. Based
on this setting, Avaya IP Office requests RTP media to be sent to a UDP port in the configurable
range for calls using LANZ2. The range used for testing was the Linux default setting of 40750 to

50750.

| System | LANL | LANZ |DNS |Voicemai| | Telephonyl Directory Ser\.ricesl System Events | SMTP | SMDR | VoIP | VolP Security | Contact Center|

LAN Settings | VoIP

Network Topology

7] Auto-create Extn

SIP Trunks Enable

[T] SIP Registrar Enable

RTP
Port Number Range

Minimum

Minimum

Keepalives

Scope

Initial keepalives

DiffServ Settings
B8 =

46 ~| Dscp

H323 Gatekeeper Enable

H.323 Signalling over TLS

Auto-create Btn/User

Port Mumber Range (NAT)

= DSCP(Hex) (B8

40750

40750

RTCP collector IP address for phones

-

Auto-create User

Disabled

TCP

TLS

10

Enable RTCP Monitering on Port 5005

5060
5060

5061

Maximum

Maximum

RTP-RTCP

|Enabled

)

Video DSCP(Heg [FC |2

-

Video DSCP 63 =

[7] H323 Remote Extn Enable

50750

50750

VI Periodic timeout

DSCP Mask (Hex) |88

DSCP Mask

34

1720

SIP Remote Extn Enable

5060

5060

51G DSCP (Hex)

51G DSCP
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Note: Avaya IP Office can also be configured to mark the Differentiated Services Code Point
(DSCP) in the IP header with specific values to support Quality of Services policies for both
signalling and media (not shown). DSCP for media can be set for both voice and video. The
DSCP field is the value used for voice and the SIG DSCP is the value used for signalling. For
the compliance test, the DSCP values were left at their default values.

All other parameters should be set according to customer requirements. On completion, click the
OK button (not shown).

On the Network Topology tab in the Details Pane, leave the STUN Server Address blank and
the Firewall/NAT Type at Open Internet as NAT is not required in this configuration.

The Network Topology tab can be used to set the Binding Refresh Time for the periodic
sending of OPTIONS. This is intended for use where OPTIONS are required at intervals of less
than 300 seconds. A value of 0 uses the default of 300 seconds.

| System | LANL | LANZ | DNS | WYoicemail |Telephony | Directory Services | System Events | SMTP | SMDR | VolP |VoIP Security | Contact Center

LAN Settings | VolP | Network Topology |

Metwork Topology Discovery
STUN Server Address 5TUN Port 3478 =

Firewall/NAT Type |Open Internet A

Binding Refresh Time (seconds) 0 =

Public IP Address 0 0 0 0 Run STUM Cancel
Public Port

uop 0

TCP 0

Bl (1l 3 (I

TLS 0

Run STUN on startup

Note: During compliance testing, registration was used with REGISTER messages sent at
intervals defined in the SIP URI settings described in Section 5.6.2. These REGISTER messages
act as a check of the SIP Trunk so that OPTIONS messages are not critical.

BG; Reviewed: Solution & Interoperability Test Lab Application Notes 10 of 35
SPOC 2/6/2018 ©2018 Avaya Inc. All Rights Reserved. SSBC_IP0O101



5.3. System Telephony Settings

Navigate to the Telephony - Telephony tab on the Details Pane. Choose the Companding
Law typical for the enterprise location. For Europe, A-Law is used. Uncheck the Inhibit Off-
Switch Forward/Transfer box to allow call forwarding and call transfer to the PSTN via the
Service Provider across the SIP trunk. On completion, click the OK button (not shown).

| System | LANL | LANZ | DS | Voicemail | Telephany |Directory Services | System Eventsl SMTP | SMDR |VoIP |VoIP Security | Contact 'Center|

Telephony | Park & Pagel Tones & Musicl Ring Tones | 5M | Call Log | TUI |

Dial Delay Time (secs) 1 = Companding Law
— Switch Line
Dial Delay Count 4 -
Default Mo Answer Time (secs) 15 = @ U-Law U-Law Line
Haold Timeout (secs) 3600 =
= @ A-law @ A-Law Line
Park Timeout (secs) 300 =
Ring Delay (secs) 5 = —
atus
Call Priority Promotion Time (secs) |Disabled 2
Auto Held
Default Currency ICHF v] Dial B
ial By Mame
Default Name Priority [Favour Trunk v] Show A  Cod
ow Account Code
Media Connection Preservation ’Disabled vl “:‘ Inhibit Off-Smitch Formard/ Tranefer
Phone Failback ’Automatlc vl [] Restrict Network Interconnect

Login Code Complexity

Include lecation specific information
Enforcement

Drop External Only Impromptu Conference

Minirmum length 4 =
Complexity ] Visually Differentiate External Call
High Quality Conferencing
RTCP Collector Configuration Directory Overrides Barring

Send RTCP t RTCP Collect
[ Sen ean pliector [] Advertise Callee State To Internal Callers

[ Internal Ring on Transfer
5005
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5.4. Codec Settings

Navigate to the VoIP tab on the Details Pane. Check the Available Codecs boxes as required for
the IP endpoints. Note that G.711 ULAW 64K and G.711 ALAW 64K are greyed out and
always available. Once available codecs are selected, they can be used or unused by using the
horizontal arrows as required. Note that in test G.711 ALAW 64K, G.711 ULAW 64K and
G.729(a) 8K CS-ACELP were used as the default codec’s. The order of priority can be changed
using the vertical arrows. On completion, click the OK button (not shown).

| System | LANL | LAN2 | DNS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | VoIP [

Ignore DTMF Mismatch For Phones |
Allow Direct Media Within NAT Location [

RFC2833 Default Payload 101 =
Available Codecs Default Codec Selection
Unused Selected
G711 ULAW G4E 3,722 64K x> 5,711 ALAW B4KE
G.711 ALAW 64K G711 ULAW 64K
3.722 64K (3.729(a) 8K CS-ACELP

G.729(a) 8K C5-ACELP

AL

>

Note: The codec settings for IP endpoints can also be used for the SIP Trunk by selecting
System Default in the Codec Selection as shown in Section 5.6.2.

5.5. VoIP Security

Avaya recommends our customers implement Avaya solutions using appropriate security and
encryption capabilities enabled by our products. To secure media using SRTP, navigate to the
VoIP Security tab on the Details Pane. Select the required level of security in the Media
dropdown menu, in the test environment Preferred was selected.

Selecting Preferred allows further configuration of media security. In the test environment,
Encryption and Authentication was applied to RTP. The SRTP Window Size was left at the
default value of 64 and in the Crypto Suites box, only SRT_AES CM_128 SHA1 80 was
selected. These settings only applied within the enterprise, VolIP Security was not used on the
SIP Trunk.
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VoIP Security is set according to customer requirements; the example shows the Lab settings:

System | LANL | LAN2 | DNS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | volp | VoIP Security

Media |Preferred - | Strict SIPS

Media Security Options

Encryptions 7| RTP
RTCP

Authentication ¥| RTP
RTCP

Replay Protection

SRTP Window Size 64

Crypto Suites
| SRTP_AES_CM_128_SHAL &0
SRTP_AES_CM_128_SHA1 32

5.6. Administer SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and Swisscom
Smart Business Connect. The recommended method for configuring a SIP Line is to use the
template associated with these Application Notes. The template is an .xml file that can be used
by IP Office Manager to create a SIP Line. Follow the steps in Section 5.6.1 to create the SIP
Line from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

IP addresses.

SIP Credentials (if applicable.)

SIP URI entries.

Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary
after the SIP Line is created via the template. The resulting SIP Line data can be verified against
the manual configuration shown in Section 5.6.2.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls
e Transport — Second Explicit DNS Server
e SIP Credentials — Registration Required

Alternatively, a SIP Line can be created manually. To do so, right-click Line in the Navigation
Pane and select New=>SIP Line (not shown). Then, follow the steps outlined in Section 5.6.2.
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5.6.1. SIP Line From Template

Copy the template file to the computer where IP Office Manager is installed. The template can
be used in one of two ways: import it and select directly as an option when creating the SIP Line;
create the SIP Line from the template as a file on the local machine. To import the file, click on

the Tools tab and select Import Templates in Manager.

File

Edit View | Tocols | Help

Conﬁgum1 Extension Renumber...

=& BOOTP (9)
H-¢# Operator (3)

7 Solution

g User(34)
-1 Group(l)
9% Short Codef(:

-5

-f3 User Rights(b

=21 ipol00sery

Export

Busy on Held Validation

MSM Configuration

- Directory(0) Print Button Labels

Server Edition Service User Management

Lo [

-7 Time Profile

Import Templates in Manager

-l Account Co

Licence Migration

~@ Location(0) Location

[ System (1)

Browse For Folder
Select a folder to import templates from -
v Swiss_SBC_[PO10-1 ~
App_Motes
Config

Location_Fault

Date created: 04/12/2017 15:47
Path: Config (C:\Users\wgleeson\Docurnents) Test Swiss_!

Traces
UPDATE_Fault
Swiss_SBC_IPO101_ASBCE .,

Cancel

To create the SIP Trunk from the template, right-click on Line in the Navigation Pane, then
navigate to New from Template. If the template file was imported as shown above, select it

directly:
=% ipol00seny

---’-:.—- System (1)

BT:f Lin _1 Mew 9
Cut Ctrl+ X a0
Copy Ctrl+C 900
Paste Ctrl+V
Delete Ctrl+ Del 4
Validate Systemn Default

Mew from Template

Export as Template

S5BC_IPC101.xrml

- ll 1P Route ()
----- #m Account Code (0)

Open from file

Alternatively, if the template file was not imported, select Open from file.
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Browse to the appropriate folder on the local machine and select Template Files (*.xml) from
the drop down menu:

1 « Swiss_SBC_|PO10-1 » Config v O Search Config o
Organize * Mew folder =~ ™ @
Test_Plan & Mame Date modified Type
= This PC || S5BC_IPO107.xml 13/11/2017 13:49 AML Document
I Desktop Type: XML Document
|§| Documents Size: 3.24 k‘B _ N
Date rmodified: 13/11/2017 13:49
‘ Downloads
J‘) Music v £
File narme: [ SSBC_IPC101.xml v| Template Files (*.xml) ~

The SIP Line is automatically created and can be verified and edited as required using the
configuration described in Section 5.6.2.
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5.6.2. Manual SIP Line Configuration

To create a SIP Line or to modify a SIP Line previously created from the template, navigate to
Line in the Navigation Pane. Right click on Line and select New (not shown) or select a SIP
Line previously created. On the SIP Line tab in the Details Pane, configure the parameters
below to connect to Swisscom Smart Business Connect.

e Set Prefix to the digit, if any, used to access an outside line. In the test environment, this
was 9.

e Set Location to that defined for Emergency calls as described in Section 5.11.

e Set National Prefix to 0 and International Prefix to 00 for number conversion as
follows: outbound national and international called party numbers are converted to E.164
format; inbound national and international calling party numbers are converted to
diallable format. If a prefix digit is used for outbound calls it should be included here.
The example shows 90 and 900 respectively.

e Set Country Code to 41 for Switzerland for number conversion, in conjunction with the
above prefixes, as follows: outbound national called party numbers are converted to
E.164 format using this country code; inbound E.164 calling party numbers are identified
as national numbers using this country code and are converted to national format.

e Ensure the In Service and Check OOS boxes are checked.

e Leave the Refresh Method at the default value of Auto which results in re-INVITE
being used for Session Refresh.

e Leave Timer (seconds) at the default value of On Demand. This value allows the
Session Refresh interval to be set by the network.

e Set Incoming Supervised REFER and Outgoing Supervise REFER to Never. REFER
is not supported by the Swisscom Smart Business Connect

e Leave all other fields at default settings.

Configuration | = SIP Line - Line 2 [ S R S 7
K 80o0TP (9) SIP Line Transpart|SIP URI|VolP | SIP Credentials|SIP Advanced |Engineering
« Operator (3)
= Solution Line Number 2 = In Service v
i User(34)
-4 Group(1) ITSP Domain Name Check 005 v
#-9% Short Code(45)
= Directory(0) Local Demain Name
;T‘ Time Profile(0] Session Timers
81 Account Code(0) URI Type s -]
-y User Rights(@) . Refresh Method Auto -
% i Locstion(l) Location ‘3. Galway v‘
=59 ipol00sery Timer (seconds) On Demand
- System (1)
Line (2)
. 1 Prefix 9
Ty, 2 . .
-2 Control Unit (11) Mational Prefix 90
E:f;’ S‘:ﬁé;’” @ Intemations! Prefix 500
‘i@ Group (0) Country Code 41 Redirect and Transfer
+-8K Short Code (53)
@ Service (0) Name Priority System Default - Incoming Supervised REFER ‘Never v|
P In.(nmmg Call Route (7) . Qutgoing Supervised REFER ‘Ne\rer v|
Directory (0) Description
Time Profile (0) Send 302 Moved Temporarily
1P Route (2) )
Quts Blind REFER
-l Account Code (0) Htgeing B
B Licence (23)

On completion, click the OK button (not shown).
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Select the Transport tab and set the following:

Set ITSP Proxy Address to the IP Address for Swisscom Smart Business Connect.
Set Layer 4 Protocol as required. During testing, UDP was used.

Set Send Port and Listen Port as required. During testing, 5060 was used.

Set Use Network Topology Info to None as NAT is not used in this configuration and
the Network Topology settings defined in Section 5.2 are not required.

On completion, click the OK button (not shown).

SIP Line| Transport SIP URI|VoIP | SIP Credentials|SIP Advanced |Enginesring|

ITSP Prowy Address  192.168.219

Metwork Configuration

Layer 4 Protocol ’UDP v] Send Port  |5060 =
Use Network Topolegy Info ’None v] Listen Port 5060 =
Explicit DNS Server(s) 0 0 0 0 a ] ] ]

Calls Route via Registrar

Separate Registrar

After the SIP line parameters are defined, the SIP credentials used for registration and
authorisation on this line must be created. To define SIP credentials, first select the SIP
Credentials tab. Click the Add button and the New SIP Credentials area will appear at the
bottom of the pane.

‘SIF' LinelTransportlSIP URIlVoIP ‘ 5IP Credentials |SIP AdvancedlEngineering|
Index UserMame Authentication Name Contact Expiry (mins) Register Add...
Remove
Edit...
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Enter the SIP ID, SIP-USER and SIP-Password provided by Swisscom here.

The SIP ID is used for the User name and Contact fields. The SIP-USER is used for the
Authentication Name. The Expiry is not used as the registration timeout is taken from the value
provided in the 200 OK Contact header received from the network. Ensure that the Registration
required checkbox is ticked.

Edit SIP Credentials

User name +413166nnnn0 QK

Authentication Name SLEE Cancel
Contact +413166nnnn0

Password sEEBLEEBLEES

Confirm Password ssssssssssse

Expiry (mins) 60 =

Registration required )

After the SIP Credentials are defined, the SIP URIs that Avaya IP Office will receive and
transmit on this line must be created. To create a SIP URI entry, first select the SIP URI tab.
Click the Add button and the New URI area will appear at the bottom of the pane.

‘URI Groups Local URI  Contact Display Name Identity Header Originator Number Send CallerID Diversion Header Credential Max Calls Add... J

‘ Remove

A SIP URI is shown in this example that is used for calls to and from extensions that have a DDI
number assigned to them. Additional SIP URI’s may be required for calls to services such as
Voicemail Collect and the Mobile Twinning FNE, these would be for incoming calls only.
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The SIP URI for calls to and from extensions that have DDI numbers associated with them was
created with the parameters shown below.

Set Local URI, Contact and Display Name to Use Internal Data. On incoming calls,
this will analyse the Request-Line sent by Swisscom and match to the SIP settings in the
User profile as described in Section 5.8. On outgoing calls this will insert the SIP settings
in the User profile into the relevant headers in the SIP messages.

Leave the Originator Number for Forwarding and Twinning blank so that the
originating number is sent as the calling party number. Select Diversion Number as the
Send Caller ID value to ensure that the DDI number assigned to the forwarding
extension is sent in the Diversion header.

Select the SIP Credentials defined previously in the Registration drop down menu.
Associate this line with an incoming line group by entering a line group number in the
Incoming Group field. For the compliance test, a new incoming group 2 was defined
that was associated to a single line (line 2).

Associate this line with an outgoing line group by entering a line group number in the
Outgoing Group field. For the compliance test, a new outgoing group 2 was defined that
was associated to a single line (line 2)

Set Max Sessions to the number of simultaneous SIP calls that are allowed using this SIP
URI pattern.

Leave other fields at default values.

On completion, click the OK button.

Edlit URI
Local URI Use Internal Data -
Contact Use Internal Data -
Display Mame Use Internal Data -
Identity
Identity Use Internal Data -
Header P Asserted ID -

Forwarding And Twinning

Originator

Murnber

Send CallerId Diversion Header A
Diversion Header MNone -
Registration 1: +413166nnnn0 -
Inceming Group 2 -
Outgoing Group 2 -
Max Sessions 10 <
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Note: If required a SIP URI can be created for calls to services such as Voicemail Collect and
the Mobile Twinning FNE: The numbers used for these services may not be associated with a
User so the incoming calls would not match the SIP settings in the User profile as described in
Section 5.8. In order to match the incoming calls with a SIP URI, the Local URI can be set either
to Auto which will match any number, or to the specific number used for the service. As this SIP
URI would be used for incoming calls only, the Outgoing Group is set to an unused value, for
example 100. The following screenshot shows an example:

Edit URI
Lecal URI +413166nnnn5 -
Contact Auto -
Display Name Auto v
Identity
Identity Mone -
Header P Asserted ID -

Forwarding And Twinning

Originator
Mumber

Send CallerId

MNone -
Diversion Header MNone -
Registration 1: +413166nnnnl -
Incoming Group 2 -
Outgeing Group 100 -
Max Sessions 10 =

The following screenshot shows the completed configuration:

|SIP LinelTransport| SIP URI |VoIP |SIP CredentialslS{P AdvancedlEngineermg|

URI  Groups Local URI Contact Display Name  Identity Header Originator Number Send CallerID  Diversion Header Credential Max Calls Add...
1 22 <Internal> <Internal> <Internal> <Internal>  PAIL Diversion Mone 1:+4131.. 10
2 2 100 +413166nnnn3  Auto Auto None PAL None None 1:+4131. 10 SR
3 2 100 +413186nnnn6  Auto Auto Mone PAL Mone None 1:+4131... 10 Edit
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Select the VoI P tab to set the VVoice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

In Section 5.4, system default codecs were defined. If any other codec combination is
required for this SIP Line, select Custom in the Codec Selection drop down menu.
Highlight codecs in the Unused box that are to be used on this line and click on the right
arrows to move them to the Selected box.

Highlight codecs in the Selected box that are not to be used and click on the left arrows
to move them to the Unused box.

Highlight codecs in the Selected box and use the up and down arrows to change the
priority order of the offered codecs if required, for testing with Swisscom, G.711 ALAW
64K, G.711 ULAW 64K and G.729(a) 8K CS-ACELP were used. This reflected the
codec list received from the network.

Select RFC2833/RFC4733 in the DTMF Support drop down menu. This directs Avaya
IP Office to send DTMF tones using RTP events messages as defined in RFC2833.
Check the Re-invite Supported box to allow for codec re-negotiation in cases where the
target of the incoming call or transfer does not support the codec originally negotiated.
Leave the Allow Direct Media Path box unchecked. Direct Media is not supported
where the network used for endpoints is different to that used for the SIP Trunk.

Check the PRACK/100rel Supported box if early media is required. This was checked
during compliance testing.

Select Media Security as required. In the test environment, Preferred was selected from
the drop down menu. Scroll down to define the security settings if required.

|SIP LinelTransportlSIP URI| VolP |SIP CredentialslSIP AdvancedlEngineering|
Local Hold Music
| Re-invite Supported
Codec Selection |CU5'E0W1 ~ Codec Lockdawn
Unused selected Allow Direct Media Path
(.722 64K _ G711 ALAW 64K ) o
G711 ULAW 64K Force direct media with phones
G.729(a) 8K C5-ACELP 7] PRACK/100rel Supported
oo
>3
Fax Transport Support |G.?11 v|
DTMF Support | RFC2833/RFCA4733 -
Media Security |F‘re‘Ferred -
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In the test environment, the system security settings were used by checking the Same As System
box. This setting uses the values described in Section 5.5. On completion, click the OK button
(not shown).

Media Security Preferred VI
Advanced Media Security Options Same As System
RTP
RTCP
RTP
RTCP
64
SRTP_AES_CM_128_SHA1 80
[E] SRTP_AES_CM_128_SHA1 32

Select the SIP Advanced tab and set the following:
e Select To Header from the Call Routing Method drop down menu. In the test
environment, Swisscom were sending the group number in the Request URI and the DDI
number in the To Header.

e Check the Use + for International as E.164 numbering is used on the SIP Trunk.

e Check the Use PAI for Privacy box to send the calling party number for outbound calls
with CLI Restricted in the P-Asserted-ldentity header.

e Select Emergency Calls from the Send Location Info drop down menu if required.

|SIP LinelTransportlSIP URIlVoIP |SIP Credentials| SIP Advanced |Engineering|

Addressing Media
Association Method ’By Source IP address - Allow Empty INVITE O
’ ] Send Empty re-INVITE [
Call Routing Method To Head - |
a7 fouting ° o Heacer Allow To Tag Change ]
Suppress DNS SRV Loockups 0o P-Early-Media Support ’None v]
Send SilenceSupp=Off [
Identity
Use "phone-context” | Media Connection ’Disabled v]
Add user=phone | Preservation
Uze + for International Indicate HOLD ]
Use PAI for Privacy
Use Domain for PAL ] Call Control
S Fi d PAI/Diversi =
wap From and PAYDiversion [ Call Initiation Timeout (5) 4 2
Caller ID from From header [
Send From In Clear [l Call Queuing Timeout (m) 5 :
Cache Auth Credentials Service Busy Response ’486- Busy Here V]
User-Agent and Server Headers on Mo User Responding Send ’408-RequestTimeout V]
Send Location Info ’Emergency Calls v] | Suppress Q.850 Reason B
Add UUT header [} Header
Add UUL header to redirected Ernulate NOTIFY for REFER 0o
calls No REFER if using Diversion [
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Note: The configuration shown in the previous page shows Location Info sent for Emergency
calls. This was not tested, but is shown for information. The settings for Location data are shown
in Section 5.11.

It is advisable at this stage to save the configuration as described in Section 5.12 to make the
Line Group ID defined in Section 5.6 available.
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5.7. Short Codes

Define a short code to route outbound traffic to the SIP line. To create a short code, right-click
Short Code in the Navigation Pane and select New. On the Short Code tab in the Details Pane,
configure the parameters as shown in the example below for public numbers.

e Inthe Code field, enter the dial string which will trigger this short code, followed by a

semi-colon.

e The example shows 9N which will be invoked when the user dials 9 followed by a public

number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to 9N so that the call is passed to the ARS function with the
dialled number unchanged.

e Setthe Line Group Id to the ARS route number described in Section 5.10.
e On completion, click the OK button (not shown).

Configuration

|z

9N;: Dial*

# || Short Code

Code

Feature

Line Group ID

Locale

Telephone Number

Force Account Code

9l

Dial

9N

50: Main

I

O

Force Authorization Code []

A further two examples are shown for an emergency number and withholding CLI:

Code Feature Telephone Line Description
Number Group ID
086756; Dial 086756 100 Emergency Services Test Number. Feature uses
Emergency Location data. Line Group ID is not used.
*679N; Dial INW 50:Main Public Number with *67 prefix. “W” suffix in
Telephone Number withholds CLI.
Short Code | Short Code |
Code 086756; Code "BT9N;
Feature Dial Emergency Feature Dial hd
Telephone Number 086756 Telephone Number ONW
Line Group ID 100 Line Group ID 50: Main -
Locale IIreIand (UK English] Locale l A
Force Account Code [l Force Account Code B
Force Authorization Code  [[] Force Authorization Code  [[]
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5.8. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP
line defined in Section 5.6. To configure these settings, first navigate to User in the Navigation
Pane. The following example shows the User tab for an H.323 Endpoint:
e Change the Name of the User if required.
e Set the Password and Confirm Password.
e Select the required profile from the Profile drop down menu. Basic User is commonly
used; Power User can be selected for SIP softphone, WebRTC and Remote Worker

endpoints.

Configuration | = Extn89105: 89105 ok -
BOOTP (@) User |Voicemai| | DND | ShortCodes | Source Numbers | Telephony | Forwarding | Dial In |‘u’oice Recording | Button Programming
Operator (3)

= Solution MName Extn89105
-§ User(34)
D"'ﬂ Group(1) Password LITTTYTYT
[-@% Short Code (45)

- Directory(0) Confirm Password sessssees
£ Time Profile(0) . )

-8 Account Code(0) Unique Identity

(-fq User Rights(@)
(-5 Location(l)

2 ipol00sery
57 System (1)

{ Line (2) Account Status Enabled -

Audic Conference PIN

Confirm Audic Conference PIN

t-<= Control Unit (11)
@9 Extension (d) Full Name
2§ User(3)
: Molser Extension 89105
g 89105 Extn89105
a 20106 Extn29106 Email Address
g 89108 Extna9108
------ §~ 89109 Extn89109
""" % Group (0) Priority ’5 ']
[-8% Short Code (53)
----- @ Service (0) System Phone Rights [None v]
(-4 Incoming Call Route (7)
----- @z Directory (0) . -
7 Time Pzﬁle ) Profile [Basm User v]
G-l IP Route (2) [C] Receptionist
----- 8 Account Code (0)
..... R Licence (23) Enable Softphone
[#-fiy User Rights (9)
- ARS (1)
(-8 Location (1) Enable one-X TeleCommuter
----- 'm Authorization Code (0)
[H-%2p GSSCP_IPO2

Locale [ v]

Enable one-X Portal Services

[ Enable Remote Worker
[] Enable Communicator

Enable Mobile VoIP Client
Send Mobility Email

Web Collaboration

[T Exclude From Directory

Device Type & Avaya 9611

Note: SIP endpoints require setting of the SIP Registrar Enable in the LANL1 settings. Navigate

to System => <IP Office Name> (not shown) in the Navigation Pane where <IP Office Name>

is the name of the IP Office. Navigate to the LAN1 = VolIP tab in the Details Pane (not shown)
and check the SIP Registrar Enable check box.
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Next select the SIP tab in the Details Pane. To reach the SIP tab click the right arrow on the
right hand side of the Details Pane until it becomes visible.

The values entered for the SIP Name and Contact fields are used as the user part of the SIP URI
in the From header for outgoing SIP trunk calls. These fields should be set to the DDI numbers
assigned to the enterprise from Swisscom in international format. In the example below, one of
the DDI numbers in the test range is used, though some of the digits have been obscured. On
completion, click the OK button (not shown).

SIP Mame

Contact

Button Programming | Menu Programming | Mobility | Group Membership | Announcements

+413166nnnnl

SIP Display Mame (Alias) Extn83105

+413166nnnnl

Ancnymous

SIP

Note: The Anonymous box can be used to restrict Calling Line Identity (CLIR).

5.9. Incoming Call Routing

An incoming call route maps an inbound DDI number on a specific line to an internal extension.
To create an incoming call route, right-click Incoming Call Route in the Navigation Pane and

select New, (not shown).
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On the Standard tab of the Details Pane, enter the parameters as shown below:
e Set the Bearer Capability to Any Voice.
e Setthe Line Group Id to the incoming line group of the SIP line defined in Section 5.6.
e Set the Incoming Number to the incoming number that this route should match on.
Matching is right to left.

e Default values can be used for all other fields.

Configuration

= 2 +413166nnnn1

‘a_

=& BOOTP (9)

-":;" Operator (3)

E-%3 Solution

H-§  User(34)

-5 Group(l)

H-@% Short Code (45)
----- s Directory(D)

£ Time Profile(0)
----- i Account Codel(0)
H-§5 User Rights(9)
-8 Location(1)
=527 ipol00sery
[H-%%p Systern (1)
F-T7 Line (2)

-2 Control Unit (11)
[E

[E

fral

H- Extension (4)
H-§  User (3)

.ﬂ Group (0}
(-8 Short Code (53)
-G8 Service (0)

P 2 +413166nnnn0
) 2 +413166nnnnl
@ 2 +413166nnnn2
@ 2 +413166nnnn3
@ 2 +413166nnnnd
P 2 +413166nnnn5
) 2 +413166nnnnG

E—j@ Incoming Call Route (7)

Standard | Voice Recording | Destinations|

Bearer Capability lAny‘u‘oice hd

Line Group ID 2 -
Inceming Number +413166nnnnl
Incoming Sub Address

Incoming CLI

Locale IFrance (French} V]

Priority ll - Low V]

Tag

Hold Music Source ISystem Source v]

Ring Tone Owerride None v

Note: A number of digits of the DDI have been obscured. Number format for incoming calls is

E.164 with leading “+”.

On the Destinations tab, select the destination extension from the pull-down menu of the
Destination field. On completion, click the OK button (not shown). In this example, incoming
calls to the test DDI number on line 2 are routed to extension 89105.

| Standard | Yoice Recording

Destinations

TimeProfile

3 Default Value

Destination Fallback Extension

(89105 Extn89105 =l

|v|

Note: Calls coming in to destinations not associated with an extension such as VVoice Mail and
FNE also appear on line 2 in this configuration. The destinations are defined as the short codes
for Voicemail Collect and the FNE Service.
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5.10. ARS

The Main ARS route exists by default and requires editing. Select the ARS Main route and click

on Add.

Configuration | =

of -

X owvl<|>

i+ Operator (3)
=457 Solution
& User(34)
2 Group(1)
~@% Short Code (45)
-8 Directory(0)
71 Time Profile(0)
-l Account Code(0)
-§4 User Rights(@)
-i@ Location(l)
=-%37 ipol00sery
-537 System (1)
17 Line(2)
~“2 Control Unit (11}
Ay Extension (4]
& User(5)
u Group (0)
8% Short Code (53)
- 4B Service (0)
@ Incoming Call Route (7)
@ Directory (0)
£ Time Profile (0)
-lill IP Route (2)
8 Account Code (0)
Wy Licence (23)
-4 User Rights (@)
- ARS (1)
g 50: Main
-8 Location (1)
ﬁ Authorization Code (D)
-7 GS5CP_IPO2

=- R BOOTP (%) ARS

ARS Route Id

Route Mame

Dial Delay Time

Description

In Service

Time Profile

50

Main

System Default (1)

) Secondary Dial tone

SystemTene

Check User Call Barring

Out of Service Route [<NDHE>

1

<None>

|

Out of Hours Route [(NDHE)

Code
7
11
an;
90035301 ICCCE0
ORCCCK
086756

Telephone Number
112

N

0035391N

0041N
086756

Feature

Dial

Line Group ID

2
Dial Emergency 2
Dial 2
Dial 2
Dial 2

2

Dial Emergency

30

Remove

Edit...

.| e} Alternate Route

<MNone»

Define numbers as required. An example for national numbers is as follows:
e Define the Short Code, the example shows both a 10 digit national number and an

international number with country code and city code prefixed with 9 for an outside line.

Select Dial in the Feature drop down menu.

e Define the Telephone Number without the 9 which removes it and sends the number as

dialled. All X characters can be replaced with a single N.

e Select the Line Group ID defined in the SIP Line URI described in Section 5.6. During

testing this was 2 for the SIP Trunk. Click on OK

Edit Short Code

Edit Short Code

Code GOROOOOOOK;
Feature Dial

Telephone Mumber 041N

Line Group 1D 2

Locale [

Force Account Code ]
Force Authorization Code [

Code 5003535100000

Feature Dial -
Telephone Mumber 0035391N

Line Group 1D 2 -
Locale [ -

Force Account Code ]
Force Authorization Code [
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The X used in the Code indicates any digit and *“;” causes the system to wait for the full number
to be dialled or a “#”. The next example shows an emergency number. Set Feature to Dial

Emergency. The number shown is not a valid Emergency Services number, it is a test number
used to check Location data.

Edit Short Code
Code 086756:
Feature Dial Emergency -
Telephone Mumber 086756
Line Group D 2 -
Locale [ -
Force Account Code [l
Force Authorization Code [

5.11. Location

If Location information is required for calls to Emergency Services, right-click Location in the
Navigation Pane and select New (not shown). On the Location tab of the Details Pane, enter the
parameters as required. An example used during testing is shown below:
e Define a Location Name.
e Define a Subnet Address and Subnet Mask as required. In the test environment, there
was no differentiation based on subnet.

e Select the Emergency ARS from the drop down menu. In the test environment default
ARS of 50: Main was used.

e In the example, all other fields were left at default values.

Configuration | =

Galway ek - X v
’s BOOTP () Location | Address
#-¢% Operator (3)
-3¢ Solution Location Name Galway
§ User34) o ) oo
a Group(l) This Location is common te all systems,
X Short Code (45) Location ID 3
< Directory(0)
£ Time Profile(0) Subnet Address 0 0 0 0
-l Account Code(0)
-§3 User Rights(9) Subnet Mask 0 0 0 0
S f ;D:fgloizg) Emergency ARS [4 Nene> v]
B System (1) Fallback System [<no overide> -
T Line (2)
(-2 Control Unit (11) <Mone»
-4 Extension (4]
& User (3) Call Admission Control
ﬂ Group (0)
(- @% Short Code (53) Total Maximum Calls ~ Unlimited -
@ Service (0]
(-3 Incoming Call Route (7) External Maximum Calls | Unlimited =
448 Directory (0] . =
£ Time Profile (0) Internal Maximurmn Calls | Unlimited 2
Hl IP Route (2)
8 Account Code (0) Time Settings
% Licence (23) Time Zone Same as System
[#-§5 User Rights (9)
E- ARS (1) 00:00
et 50: Main
Bn'—q Location (1)
-8 3: Galway <Add New Entry> Edit Delete
m Authorization Code (0)
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Click on the Address tab and enter data as required. The following screenshot shows an example
used during testing:

| Location| Address |

RD

PRD

POD

5TS

PRM

POM

RDSEC

RDBR

Country Code

Connacht
Galway
Galway
Mervue

Business Park

Units 25-29

RDSUBBR

1, Please refer to the help for Information regarding this screen. Failure to format the address properly
could result in improper address association,

HMO

HMNS

LMK

BLD

Loc

PLC

FLR

UNIT GS5CP Lab
ROOM

SEAT

NAM 123456
ADDCODE

PCN

PC

POBOX

Note: The above example bears no relation to the information that would be used in the live
environment. It was specified for the sole purpose of being identifiable in the SIP messages of
the test calls.

The location data defined in the test environment is applied to the whole IP office. This can be
refined according to subnet and also individual extensions. The SIP Line is configured to send
location data as described in Section 5.6.2.
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5.12. Save Configuration

Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.

File

Edit View Tools Help

Open Cenfiguration...  Ctrl+0

Close Configuration

|Q Save Configuration Ctrl+5 ummary

Save Configuration As.., Server Edition Primary

Change Working Directory...

Preferences... - Hardware Installed

) Control Unit: IPO-Linux-PC

Offline Secondary Server, NONE

Advanced Expansion Systems: 10.10.4.100

Backup/Restore System ldentification: b Do zadB 40 3 2Ny Do s e cbd dvdds 3o 2

Emport/Export Serial Nu.mber: N2ohEHA sl

= System Settings

Exit IP Address: 10.10.4.101
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6. Configure the Swisscom Equipment

The configuration of the Swisscom Smart Business Connect equipment used to support the SIP
Trunk is outside the scope of these Application Notes and will not be covered. To obtain further
information on Swisscom equipment and system configuration please contact an authorized
Swisscom representative.

7. Verification Steps

This section includes steps that can be used to verify that the configuration has been done
correctly.

7.1. SIP Trunk status

The status of the SIP trunk can be verified by opening the System Status application. A Windows
7 PC was used for testing and the application was opened by pressing the Start button and
selecting All Programs—> IP Office - System Status.

. [P Office . ;
) Devices and Printers
D\ TP Office Knowledge Base
E Manager
&l Monitor
L]
| of System Status S Help and Support
Uninstall IP Office Admin Suite

. Java -

1 Back

Default Programs

Log in to IP Office System Status at the prompt using the Control Unit IP Address for the IP
Office. The User Name and Password are the same as those used for IP Office Manager.

IP Office System Status

Online |offine

Logon

Control Unit IP Address: BURIERTGE

Services Base TCP Port: Ell:=LI1

(T BT H 2dmini strator

Password:

[l Auto reconnect

[l Secure connection

sion 10.1.0.0.0 build 237
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From the left hand menu expand Trunks and choose the SIP trunk (2 in this instance). The status
window will show the status as being idle and time in state if the Trunk is operational.

ﬁ. e - . i
+J Avaya IP Office System Status - ipo100serv (10.10.4.101) - IP Office Linux PC 10.1.0.0.0 build 237 | = | & % |
— R~

IP Office System Status

Status | tiization Summary Alarms  Registration

SIP Trunk Summary

Line Service State: In Service

Peer Domain MName: sip:ff192.168.2.19
Resolved Address: 192,168.2,19

Line Mumnber: 2

Mumber of Administered Channels: 30

Mumber of Channels in Use: 0

Administered Compression: G711 A, G711 Mu, G729 A
Enable Faststart: Off

Silence Suppression: off

Media Stream: RTP

Layer 4 Protocol: UDF

SIP Trunk Channel Licenses: 256 . y

SIP Trunk Channel Licenses in Use: 0

SIP Device Features: UPDATE (Incoming and Outgoing)
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8. Conclusion

All tests for Swisscom Smart Business Connect were completed. Observations for the testing are
listed in Section 2.2.
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9. Additional References
Product documentation for Avaya products may be found at http://support.avaya.com.
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are the property of their respective owners. The information provided in these Application
Notes is subject to change without notice. The configurations, technical data, and
recommendations provided in these Application Notes are believed to be accurate and
dependable, but are presented without express or implied warranty. Users are responsible for
their application of any products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya
DevConnect Program at devconnect@avaya.com.
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